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Taskmaster Server Service/Server  

This chapter examines the structure, components and operations of the TMS 
Configuration dialog…and the Taskmaster Server window. 

• The TMS Configuration dialog sets up and manages the Taskmaster Server 
Service. This service is a standard component of all versions since Taskmaster 6.2
 – and replaces the Taskmaster Server component of earlier releases. 

• For the benefit of those who continue to use Taskmaster Server, the second 
section describes the elements and tools of the Taskmaster Server Window. 
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Taskmaster Server Service 
The Datacap Taskmaster Server Installation process installs the Taskmaster 
Server Service. For complete installation and configuration instructions, see 
the Taskmaster 7.5 Installation and Configuration Guide. 

How to Access Taskmaster Server Service Components 
Shortcut to the Taskmaster Server Service and the Taskmaster Server Guide are in two 
locations. In the illustration below, the path to these shortcuts begins when you click on 
the Windows Start button of the computer that is your Datacap configuration’s File 
Server, and select the Programs options. You can find the same shortcuts if you open the 
Datacap Taskmaster folder on the computer’s desktop. 
 

 

Taskmaster 
Server Service

 

 

9 Very important! Selecting the Taskmaster Server shortcut opens the TMS 
Configuration dialog (Page 6) - not the service itself.  Taskmaster 6.5 does not provide a 
comparable shortcut for the Taskmaster Server used by releases before Taskmaster 6.2. 
Page 13 shows you how to access this server.  

The Taskmaster Server Service (TMS) is a required component of Taskmaster in all versions 
after Taskmaster 6, Release 5. 
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Important Preliminary Considerations 

Important Preliminary Considerations 
Î Because Taskmaster Server Service is a service, installation produces an item for Datacap 

Taskmaster Server Service in the host computer’s list of local services. To display this list: 

♦ Open the computer’s Control Panel. 

♦  Select Services from the Administrative Tools. 

♦ Highlight Services (Local) under the Tree tab. 

 

Automatic 

Settings/Control Panel/Administrative Tools/Services 

Î You can right-click on the listing for Datacap Taskmaster Server Service and 
select Properties from the options to open Service Properties dialog. The fields and 
features of this dialog support and extend those of the TMS Configuration dialog (Page 
6). The Service status field, for example, displays the service’s current operating status. 
And the Startup Type drop-down list lets you choose between Manual, Automatic and 
Disabled… choices that are not available in the TMS Configuration dialog.  

Î The TMS Configuration dialog requires Microsoft’s .NET Framework. If the .NET 
Framework has not been set up on the service’s computer, Datacap Taskmaster 
Installation will install it automatically.  For more information, see the Taskmaster 7.5 
Installation and Configuration Guide.
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Taskmaster Server Service Properties dialog 

How to Access the TMS Configuration Dialog 
To access this dialog, click on the host computer’s Windows Start button. Select the 
Datacap Taskmaster option from Programs options. Open the Taskmaster Server 
folder and double-click on the Taskmaster Server icon. 

 

9 Remember! The “Taskmaster Server” icon opens Taskmaster Server Service only. 

Alternatively, you can open the Datacap Taskmaster folder on the computer’s desktop 
and the Taskmaster Server sub-folder – then double-click on the Taskmaster Server 
icon. 

Both approaches open the TMS Configuration utility and its TMS Configuration dialog. 
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TMS Configuration Dialog 

TMS Configuration Dialog 
Titles of the TMS Configuration dialog’s four tabs are arrayed along the top; clicking on 
a title opens the tab and its settings. 

At the bottom of the dialog: 

• The Save button saves any changes you’ve made to the service’s settings.  

• The Close button closes the TMS Configuration utility. 

 
TMS Configuration dialog – Service tab 

Service Tab 
This introductory tab displays the service’s Name and its processing Status. The tab’s 
four buttons determine the all-important Status condition.  

 
TMS Configuration dialog – Service tab 
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Service tab - Start and Stop Buttons 

These buttons toggle the service in and out of two statuses: Running and Stopped.  

Stop. Clicking on this button stops the Taskmaster Server Service.  

Start. Clicking on this button starts the Taskmaster Server Service.   

Note: you can make changes to the Taskmaster Server Service settings while the service 
is running, but changes to settings marked “Requires Restart” will not take affect until the 
service is stopped, then re-started.  

( Be careful. Make sure all Taskmaster Client stations or other server-dependent programs 
are logged out before stopping the Taskmaster Server Service.  Otherwise, these 
programs will lose connections to the application databases, and no longer process 
batches (see Page 11). 

Service tab - Pause and Resume Buttons 

You can use the Pause button to interrupt the service. Although the service ceases its 
activities, you cannot work with settings in this or other tabs. Clicking on the Resume 
button begins Service operations. 
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TMS Configuration Dialog 

Taskmaster Tab 
Settings in this tab configure the service. 

 
      TMs Configuration dialog – Taskmaster tab 

The table below describes the tab’s fields and functions. Alert! The Show Advanced 
button displays additional settings in the tab’s bottom area. 

Field/Setting/Function Description 

Accept Connections on Port Designates the TCP/IP port that the service will accept 
connections from. 

Queue by Determines if connected Taskmaster Clients will 
process batches queued first according to job (by Job), 
or according to task (by Task). 

Child job inherits priority If checked, stipulates that the Priority property of a 
child job (such as FixUp) will be the same as that of its 
parent job. 

Save deleted batch info in debug 
table 

Ensures that information from deleted batches will be 
stored in the Debug table of the application’s Engine 
database.  

Hide Advanced button Hides the tab’s advanced section. 

Database command timeout 
(requires restart). 

Specifies the maximum time (in seconds) that the 
service can hold a database open after the most recent 
client access. 
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Field/Setting/Function Description 

Clients access database in… Determines how clients will access databases 
monitored by the service: 

Sequence means that clients must access a database
      one by one.  

      Parallel allows multiple clients to access a 
      database concurrently. 

Periodic lock If checked, directs Taskmaster Server Service to “lock” 
each database occasionally, as a Security measure. 

The locking procedure cannot last longer than the 
Database Command Timeout value (above).   

Job Monitor default sorting 
condition (ORDER BY – SQL) 

Indicates how an application’s Job Monitor will sort 
listings in its Batch Information Table. 

Example:  ORDER BY pb_batch DESC, qu_id DESC 

Reset to Defaults Resets the tab’s specifications to default values. 
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TMS Configuration Dialog 

Logging Tab 
This tab contains criteria the service can use to generate two logs of its activity: 

 
TMS Configuration dialog – Logging tab 

The Event log records Windows events. Your placement of the indicator in the 
Messaging Level section determines the nature and volume of the log’s messages. 

The Datacap log tracks the progress of Taskmaster Server Service. 

The indicator in the Number of Messages continuum selects messages according to 
the seriousness of their content. A shift from left to right results in more messages, 
but messages of a less critical nature. 

Selecting the Write to common buffer directs the service to place the log’s entries 
in a “common buffer” so they will available to Taskmaster’s Log Viewer.   

Output to file is an option which, if checked, generates a single Log file covering the 
service’s activity. Be sure to enter the file’s name and path in the accompanying 
field. 

If you select the Overwrite Existing Log File option, the service will replace the 
current file each time it generates a new file. If you intend to append messages to 
the existing Log file, do not select this option 

Reflush buffer on each message, if checked, means that the service will 
continuously transfer messages from a mid-stream buffer to the log as the 
service’s operations proceed. 

If you do not select this feature, Taskmaster will store messages in a buffer for a 
particular period. This alternative may increase processing speed but 
compromises safety: if Taskmaster crashes, you lose the messages in the buffer. 

Page 2–10 Confidential and Proprietary Information of Datacap Inc. 
 Copyright © 2006 Datacap Inc. 



Chapter 2: Taskmaster Server Service/Server 

9 Be careful. A Datacap log can grow steadily and quickly, until it becomes 
cumbersome. Therefore, we recommend that you limit the use of this tool to testing. 

File System Access Mask Tab 
This tab gives Taskmaster Server Service access to specific folders, individual files (by 
name), or file categories (according to extension) – or denies such access. 

 
TMS Configuration dialog - File System Access Mask tab 

When you click on Folders and press the Defaults button at the bottom of the tab, there 
are no Allowed folders – but there are a number of Blocked folders. This is because all 
folders in the Datacap configuration are allowed unless they have been blocked.  

 

The File Names and File Extensions hierarchies have the same structure. 
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TMS Configuration Dialog 

 
Taskmaster Configuration dialog – File System Access Mask tab 

How to Modify Configuration Settings 
After you have set up the service, you can change specifications in the tabs of the TMS 
Configuration dialog at any time - unless a setting is marked Requires Restart. In this 
case, you have to stop the service after you make the change, and start it, before the 
change takes effect. 

 

To reduce the possibility of confusion, we strongly recommend that you stop the service 
before you make any changes except those of the Logging tab (Page 10): just click on the 
Service tab’s Stop button.  

Be careful. Make sure all Taskmaster Client stations or other programs that are 
dependent on Taskmaster Server Service are logged out before stopping the service.  
Otherwise, these programs will loose their connections to the application databases, and 
can no longer process batches. 
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Taskmaster Server (Taskmaster 6.0 and Earlier)  
Releases of Taskmaster before Taskmaster 6, Release 2 included a server (Taskmaster 
Server) rather than a service (Taskmaster Server Service.) Taskmaster 6.2 provided both 
but strongly favored the use of the service.   

9 The Windows & Dialogs Reference that accompanied the earlier releases fully 
documented the many features and functions of the Taskmaster Server window itself. 
The current edition of the Windows & Dialogs Reference does not go to this level of 
detail. Instead, it highlights the key points of the earlier documentation. 

9 Very important! The descriptions which follow are addressed to those who use Task 
Master Server rather Taskmaster Server Service.   

Accessing Taskmaster Server             
For users of Taskmaster 6.0 and earlier releases, Application Security (Chapter 6) places 
strict limits on personal access to Taskmaster Server and to the computer on which it 
resides. If you have proper authorization, however, you can activate the server from your 
Windows Start button or from the Datacap Server folder on your desktop. (Remember! 
These descriptions apply only to Taskmaster releases before Taskmaster 6.2.) 

To Access Taskmaster Server from the Start Button…. 

Step Action 

1. Click on the Start button in the lower left-hand corner of your Windows 
screen. 

2. Select Datacap Server from the Programs directory. 

3. Click on the Server option. This step engages Taskmaster Server and readies 
it for connections with Taskmaster Clients. 

4. When the Taskmaster Server window appears with an empty Connections 
window (illustrated on the next page), press the Minimize button in the upper 
right-hand corner: the window will disappear from your screen and the 
Taskmaster Server icon will appear in your Windows taskbar: 

 

5. Select Datacap Client from the Programs directory, then click on the 
Applications option. 
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Accessing Taskmaster Server 

 

To Access Taskmaster Server from the Start Button (continued)  

Step Action 

6. Double-click on the Client option of your application, or of a training 
application such as 1040EZ. This step will connect your administrative 
Taskmaster Client with Taskmaster Server, with this application’s databases, 
and with the application’s Security program. Note: Do not select the 
Serverless option. 

7. To meet the initial requirements of the Security program, enter your 
Administrator’s User ID and Password in the User ID & Password dialog, 
and press the OK button. 

 

8. When the application’s Taskmaster Window appears, press the Minimize 
button in the upper right-hand corner: the Taskmaster Client icon will join 
the Taskmaster Server icon in your taskbar: 

 

9. Click on the Taskmaster Server icon to return to the Taskmaster Server 
window. Note that the secondary Connections window now has one row, 
with details of the connection between your client and Taskmaster Server (see 
the illustration on Page 17). 
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To Access Taskmaster Server from your Desktop…. 

Step Action 

1. Double-click on the Datacap Server folder on your Windows desktop. 

 

2. Double-click on the Server icon. This step engages Taskmaster Server and 
readies it for connections with the application’s Taskmaster Clients 

 

3. When the Taskmaster Server window appears with an empty Connections 
window, press the Minimize button in the upper right-hand corner: the 
window will disappear from your screen but the Taskmaster Server icon 
will appear in your Windows taskbar 

4. Close the Datacap Server folder (but not Taskmaster Server!) and open the 
Datacap Client folder. 

5.  Double-click on the Applications folder.  

 

6. Double-click on the appropriate application, then on the application’s Client 
icon. 

Confidential and Proprietary Information of Datacap Inc. Page 2–15 
Copyright © 2006 Datacap Inc. 



Accessing Taskmaster Server 

 

To Access Taskmaster Server from your Desktop (continued)  

Step Action 

7. When the User ID & Password dialog appears, enter your Administrator’s 
User ID and Password, and press the OK button. 

 

8. When the Taskmaster Window appears (Chapter 3), press the Minimize 
button in the upper right-hand corner: the Taskmaster Client icon will join 
the Taskmaster Server icon in your Windows taskbar: 

 

9. Click on the Taskmaster Server icon to access the Taskmaster Server 
window (illustrated on the next page). Note that the secondary Connections 
window now has one row, with details of the connection between your client 
and Taskmaster Server.  

Upcoming pages briefly examine each of the Taskmaster Server window’s elements and 
settings. As an introduction, however, take a moment to review the following 
components of its overall structure. 

Menus. Items in the menus of the Taskmaster Server window support your network 
administration activities; these are described on Page 18. 

Toolbar. The toolbar icons duplicate the functions of most menu items (Page 18). 
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Data Area. The Data Area of the Taskmaster Server window contains the secondary 
Connections window. This window displays information about Taskmaster Clients 
currently connected to the Taskmaster Server (Page 21). 

Network Data. The fields in this bar identify the server port providing service to the 
clients and the server’s network protocol. These fields are unavailable unless you 
need to modify the structure of the Datacap network (Page 18). 

Status Bar.  The Status Bar is a dynamic display of statistics covering connections 
between the server and its active clients.  Data in the Status Bar changes constantly as 
the server responds to the inquiries of each client (Page 21.) 

Remember! A Taskmaster Client cannot connect to an application’s Taskmaster Server 
until all of the following conditions are met: 

• The Taskmaster Client has been properly installed, and set up as part of a 
Datacap network. 

• The server has been equipped with an ODBC driver and Data Source Names 
(DSN) giving the client access to the application’s Admin and Engine databases 
(Page 28). 

• The client resides on an authorized workstation (Chapter 6). 

• The client’s user (Operator, Supervisor or Administrator) signs on with an 
authorized Password and User ID (Chapter 6). 

 

 

    Connection 

      Status 
      bar 

      Network 
      data 

   Taskmaster Server Window–with secondary Connections Window 
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Taskmaster Server Window–Menus and Toolbars 
Items in the menus of the Taskmaster Server window help you manage the network’s 
services and connections; communicate with users; and administer an application’s 
databases. The table below summarizes each menu. 
 

 
 

 Menu Description 

Service Taskmaster Server connects Taskmaster Clients to your Datacap 
Taskmaster network, to an application’s files and databases, and to its 
Security procedures.  The items in the Service menu help manage 
these client/server connections. 

View Items in the extensive View menu (and its sub-menus) determine the 
content and layout of the Taskmaster Server window. 

Tools Items in the Tools menu and sub-menus set up informal 
communications between you and the other  “users” of the Datacap 
network. In addition, this menu generates a log of server activity and a 
list of the server’s components. 

The menu’s ODBC Manager is the source of database management 
and maintenance procedures.    

Window These are standard Windows layering selections, and the identities of 
connected clients. 

Help The Help menu contains “legends” explaining the icons in a 
Connections window listing and in the Status Bar. The menu also 
gives you access to the Datacap Home Page, and links you by e-mail 
directly to our support team. 

 
The toolbar icons of the Taskmaster Server window duplicate certain items of the 
window’s menus. The table below explains the menu items and their corresponding 
icons, while subsequent paragraphs offer additional information about certain of the 
window’s special procedures. 

9 Selecting Customize from the View menu accesses the Customize Connections dialog. 
You can alter the layout and content of the Taskmaster Server window’s menus and 
toolbar if you modify the settings in the tabs of this dialog 
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Icon  Menu/ Item Description 

 
Service/ 
Start 

Re-starts the server if you temporarily halt service to the 
network. 

This is a toggle switch: when it is on, the Stop icon (below) 
is off. 

 
Service/Stop Temporarily prevents the server from providing service to 

connected clients. 

This is a toggle switch: when it is on, the Start icon (above) 
is off. 

 

Service/Stop 
All 

Terminates service to all connected clients and closes the 
connections. 

Warning: if you use this option, each client must 
independently re-establish its connection with the server. 

 

Service/Stop 
Selected 

Terminates service to any clients you’ve highlighted in the 
Connections window. (This icon appears only if the 
Connections window is active.) 

Again, if you use this option, each client must independently 
re-establish its connection with the server. 

 
View/ 
Properties 

Accesses the tabs of the Channels Properties dialog. 

These tabs display the properties of a highlighted 
connection.. Again, this icon appears only if the Connections 
window is active. 
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Taskmaster Server Window – Toolbar (continued)  
Icon  Menu/ Item Description 

 
View/Options Access the three tabs of the Options dialog. 

The settings in these tabs govern important functions of 
Taskmaster Server. 

 
Tools/ 
Send Message 

Accesses the Send Messages dialog. 

You can use this dialog to transmit messages from you to 
the network’s connected clients. 

 

Tools/Chat Accesses the Chat dialog. 

You can use the Chat dialog to set up, monitor and 
participate in a Chat Room for network users. 

 
Tools /ODBC 
Manager 

Accesses the Windows ODBC Data Source 
Administrator dialog.  

You can use this dialog to carry out an application’s 
database maintenance activities. 

 
Tools/Log 
Viewer 

A toggle switch which opens or closes the server’s Log 
Viewer. 

 
Tools/Log to 
File 

A toggle switch which adds data in the current log 
(above) to a Log file  if the switch is on. 

 
Help/Datacap 
on the Web 

Accesses the Datacap Home Page (www.datacap.com). 

 

Help/About 
Taskmaster 
Server 

Displays Taskmaster Server’s version number and 
Datacap Support information  

 
Service/ 
Stop All and 
Exit 

Terminates all connections and closes Taskmaster Server. 
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Taskmaster Server Window–Connections Window  
The Taskmaster Server window operates in one of two modes–with or without the 
secondary Connections window. When the Connections window is active, it occupies 
the Data Area of the Taskmaster Server window.  

Each row contains information about the connection between one client and the server.  

 

 
Taskmaster Server Window–Secondary Connections Window 

The table below explains the data in the rows of the secondary Connections window. 

Column Description 

  or 

An icon indicating that a channel is open between the client and server 
but that the client is not actively connected to the server. 

 

An icon indicating that a channel is open and the client is connected. 

Note: If you right-click on one of these icons, Taskmaster  displays a 
legend explaining the role of each. 

Local Port The port on Taskmaster Server to which the client is connected. 

Status The status of the connection between the client and the server. 

Remote Address The TCP/IP address of the connecting client. 

Remote Port The port on the Taskmaster Client to which the server is connected. 

Connected at The time and date of the current connection.  

Station ID An authorized Station ID assigned to the connecting workstation. 

User ID The User ID assigned to the individual who is signing on to the 
application from this workstation and Taskmaster Client. 

 

( If your configuration uses Taskmaster Web technology to link remote clients to an 
application by way of the Internet, the Connections window will list all clients – 
central and remote.  

Confidential and Proprietary Information of Datacap Inc. Page 2–21 
Copyright © 2006 Datacap Inc. 



Taskmaster Server Window–Status Bar 

Taskmaster Server Window–Status Bar 
Additional information about current client/server connections appears in the Status Bar 
at the bottom of the Taskmaster Server window: 

 
 

Taskmaster Server Window–Status Bar 

For a convenient explanation of the Status Bar, click on the arrow at the right end of the 
bar to retrieve a legend that uses sample data rather than actual data for illustrations: 
 

 
Status Bar Legend 

At the left end, the Status Bar displays text describing the status of a connection and, 
often, full addresses of the connection between server (127.0.0.1:2402 in the actual 
example above) and client (127.0.0.1:1034).  

Average Response Time (Rpns) is a measure of the average time (in milliseconds) 
required to maintain the connection between this client and the server during this session. 

This is followed by the IP Address of the server (127.0.0.1, in the actual example). 

The Status Bar then indicates the number of open channels. (In both examples, there is 
“1” open channel connecting a client to the server.) 

The two signal lights at the right end of the Status Bar turn on and off in response to the 
state of the server’s modem: 

♦ Both off: the modem is idle. 

♦ Left on, right off: the server is receiving data from a client. 

♦ Left off, right on: the server is sending data. 
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Service on Port, Network Type: Starting and Stopping Service 
If a client is running without any apparent difficulty, the Service on Port and Network 
Type fields above the Status Bar are unavailable, and the text field of the Status Bar 
notes that the server is Ready or Listening on Port nnnn. 
 

 

 
From time to time, you may want to adjust the Service on Port specification (below) 
while one or more clients are connected. Although, technically, you can select a different 
network protocol, most Taskmaster applications use TCP/IP and we strongly recommend 
that you change this setting only after you consult your network administrator. 

9 To change a setting, highlight the client’s listing in the Connections window and select  
Stop or Stop All from the Service menu: the Service on Port and Network Type fields 
will become available to you. 

 

 

If you then select Start from the Service menu, Taskmaster Server will restore the 
connection and continue its operations. 

( Be Careful: Selecting Stop or Stop All closes the connection completely between a 
client and the server. To restore the connection, the user must sign-on again. 
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Channel Dialog: Properties of a Client/Server Connection 
If you highlight a client/server connection in the secondary Connections window and 
select Properties from the View menu, the Channel tab of the Channel dialog will 
appear on your screen. This tab supplies details of the connection–timing, IP addresses 
and port numbers–and the connection’s status (Idle in the example below). 

 
Channel Dialog–Channel Tab 

The Station tab displays the identifying codes of the workstation on which the connecting 
Taskmaster Client resides, and the user. This tab also identifies the client’s Data Source 
Names, and generates current workflow data covering Job, Task and Batch production.    
 

 
Channel Dialog–Station Tab 
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Components Information Dialog: Properties of the Server 
Selecting Components Information from the Tools menu results in a partial list of the 
server’s properties: 
 

 
Components Information Dialog 
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Communicating with Users 
The Taskmaster Server window has tools you can use to send a message to one or more 
connected Taskmaster Clients, or to open a temporary Chat Room for everyone’s benefit. 
(As Chapter 3 explains, you can also send Taskmaster e-mails or open a Chat Room 
directly from the Administrator’s Taskmaster Client, using similar features in the 
Taskmaster Window.) 

Network E-mail (Datacap) 
To compose and send a message to one or more connected clients, select Send Message 
from the Tools menu (or click on the Send Message icon) to access the Send Message 
dialog. 
 

 
Send Message Dialog 

When the Send Message dialog appears, enter the wording of the e-mail in the Message 
Text field.  

• To distribute the message to all connected users, click on the Broadcast radio 
button and press the Send button.  

• To limit distribution to one or more users, first activate the Private radio button. 
Then highlight the applicable connections and press the Send button.  

9 The message will appear automatically on the screen of the targeted users (see the 
illustration on the next page.) 
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Message Alert! 

Chat Rooms 
The Chat dialog is a give-and-take bulletin board for messages from members of the 
network. Although you can open such a discourse right from the Taskmaster Server 
window, others can use the tools of the Taskmaster Window to initiate a chat or to 
participate (Chapter 3).  

To Open a Chat Room 

Step Action 

1. Enter the message in the Outbound area 

2. Select the Private option and highlight Chat Room participants in the list of 
signed-on stations; or Broadcast your thoughts to everybody on the network. 

3.  Press the Send button.  
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Server Options 

General Settings 
The installation of a Datacap Taskmaster configuration sets up Taskmaster Server on a 
computer you designate. It also sets up one or more Taskmaster Clients, and mechanisms 
to link the clients to the server. 

Settings in the General tab of the Options dialog determine certain aspects of the server’s 
operations and its interactions with clients. Although these are default settings, be sure to 
consult your Datacap Implementation Specialist before making any changes. 

To access this tab, select Options from the Tools menu, and click on the General tab. 
 

 
Options Dialog–General Tab 
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Miscellaneous Settings 
Taskmaster Server’s Options dialog has a Miscellaneous (Misc.) tab. 
 

 
Taskmaster Server Window–Options Dialog 

Miscellaneous Tab 

This tab has two settings: 

• Selecting the Animation option adds background animation to displays in the 
Channel Properties dialog (Page 24) and the About Taskmaster Server dialog 
(Page 18). 

• Activating Sounds on Various Events gives you access to the Sounds 
Properties dialog. 

Log Settings 
Settings in the Log tab of the Options dialog determine whether or not Taskmaster Server 
will generate a log of its activities. If there is to be a log, these settings determine its 
nature and content. 
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Data Source Management 

Data Source Management  
The database configuration of a Taskmaster application is uncomplicated:  

• The Admin database contains settings that determine the makeup and operation 
of an application’s workflow, and details of Application Security. 

• The Engine database contains the results of the workflow’s activity- job-by-job, 
and task-by-task.  

• The Rules database holds details of an application’s rules and their actions. 

• The Lookup database contains values used by an application’s Validation 
procedures. 

Often, an application includes other data sources…a secondary database, for example, 
that stores data for export. Or maybe a list of authorized values an application uses to 
validate the data a particular field. 

To be part of a Taskmaster application, a data source may require two administrative 
components: 

• Open Database Connectivity (ODBC) driver.  The assignment of an ODBC 
driver ensures that your Taskmaster application can read the information in a 
database or other data source and, if applicable, write data to the database.  

• Data Source Name (DSN). A Data Source Name is a set of specifications. These 
specifications identify a specific data source–usually a database such as the 
Engine or Admin database–and its corresponding ODBC driver. 

Taskmaster comes equipped with a full set of ODBC drivers, and the tools you’ll use 
define a Data Source Name. Together, these features allow you to add a data source to an 
application, or modify the specifications of an existing Data Source Name. 

Taskmaster Server’s ODBC Data Source Administrator is the scene of an application’s 
data source management procedures - and a vital source of data source information. To 
access this dialog, select ODBC Manager from the Tools menu of the Taskmaster 
Server window. 

9 Very Important! Taskmaster 6.2 employs Connection Strings to link various components 
to individual databases. Appendix A of the Taskmaster Administrator’s Guide explains 
the use of Connection Strings for Access, SQL Server and Oracle databases, and 
carefully defines the syntax for each string.    
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ODBC Data Source Administrator–System DSN Tab 
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How to Define a Data Source Name 
Remember…a Taskmaster Data Source Name has two elements: a data source (such as 
an Access database), and an ODBC driver. 

The steps below show you how you might establish a DSN for an Access database in the 
1040EZ training application. The procedure assumes that you have previously defined the 
database (validate.mdb) and placed it in the application’s Process directory. 

To define a DSN for this database: 

Step Action 

1. Select ODBC Manager from the Tools menu: the ODBC Data Source 
Administrator will appear on your screen. 

2. Access the System DSN tab. 

 

3. Press the Add button to retrieve the Create New Data Source mini-wizard.  

 

4. Select the Name of the applicable ODBC Driver – in this case, the Microsoft 
Access Driver – and press the Finish button at the bottom. An empty ODBC 
Microsoft Access Setup dialog will appear (see the next page.) 
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To Define a DSN (continued)  

Step Action 

5. Click on the Select button to access the Select Database dialog. 

 

6. Highlight the Name of the Data Source - in this example, the Access database 
– to which you are assigning the DSN. Press the OK button to return to the 
ODBC Setup dialog. 

 

7. Confirm the Database name and pathway information  

8. Enter the Data Source Name for this database – 1040ezval, in the example. 

9. Add a brief but important Description of the Data Source Name. 
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To Define a DSN (continued)  

Step Action 

10. Check your settings. 

11. Click on the OK button to return to the System DSN tab of the ODBC Data 
Source Administrator. 

12. Be sure the new Data Source Name appears in the tab’s list of System Data 
Sources. 

 

13. Close the ODBC Data Source Administrator. 

 

9 Setting up a new DSN is an important but “forgiving” procedure. Don’t hesitate to 
experiment with different data source types and their drivers. Once you’ve installed a 
DSN, you can remove it easily with a click of the Remove button. 
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ODBC Data Source Administrator: User DSN Tab 
A “user” DSN is a Data Source Name for a Data Source associated with the computer on 
which the ODBC Data Source Administrator is running. These DSN’s can also include 
the identity of a Taskmaster user.  

To access this tab, select ODBC Manager from the Tools menu of the Taskmaster 
Server window…then click on User DSN. 
 

 

                Patty 

               Mike 

ODBC Data Source Administrator–User DSN Tab 

User DSNs are effective when a Datacap network provides access to multiple users from 
a single computer. The User DSNs you define then determine which applications a user 
can access…and which data sources within the application. In the illustration above, 
Mike can work with the Fuse application, while Patty has access only to the Index 
application. 

The steps you take to define the User DSN are identical to those you take when defining 
a System DSN (Page 32). 

9 Each User DSN requires the definition of a corresponding Windows User Profile; after 
you assemble the User DSN, you’ll include it in the User Profile. 

ODBC Data Source Administrator: File DSN Tab 
Taskmaster applications do not use the standard specifications of the File DSNs.  As a 
result, the options in this tab are not available. 
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ODBC Data Source Administrator: Tracing Tab 
The Tracing tab gives you an opportunity to track “calls” from Taskmaster Clients to the 
server’s ODBC drivers. To access this tab, select ODBC Manager from the Tools menu 
of the Taskmaster Server window…then click on Tracing. 
 

 
ODBC Data Source Administrator–Tracing Tab 

This aspect of Data Source Management is entirely diagnostic: the result is a log with the 
minutiae of every event involving each Taskmaster Client’s use of any ODBC driver. 
Here are the details of just one such event: 
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ODBC Data Source Administrator: Connection Pooling Tab 
Settings in the Connection Pooling tab allow multiple Taskmaster Clients to take 
advantage of a single gateway to Data Sources employing a particular ODBC driver. 

In the illustration below, as soon as one client opens a database with a SQL Server or 
Oracle driver, the database remains open and available to other clients until the Pool 
Timeout period expires.  
 

 
ODBC Data Source Administrator – Connection Pooling Tab 

9 Connection Pooling can be a productive database management technique. Be sure to 
consult the applicable Microsoft documentation for a complete explanation. 
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ODBC Data Source Administrator: About Tab 
Unlike most About tabs, the About tab of the ODBC Data Source Administrator has 
useful information. 
 

 
ODBC Data Source Administrator–About Tab 

Taskmaster operates only with a 32-bit Windows operating system. To be sure that your 
host system’s ODBC components are compliant, check the titles of the files in the list. 
Each file name except odbcint.dll should include a “32” designation. 
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